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What is the definition of the input for an independent sample t-test?

The independent sample t-test is a statistical analysis method used to compare the means of two
independent groups. The input for this test consists of two independent samples, where each
sample represents a different group or condition being compared. These samples must be
normally distributed and have equal variances in order to accurately assess the difference in
means between the two groups. Additionally, the input should also include the level of significance,
or alpha value, to determine the significance of the results. This test is commonly used in research
studies to determine whether there is a significant difference between two groups on a particular
variable.

Define Input of Independent Sample T-Test

In this section, we will learn Independent sample T-test,
and how to calculate the differences between two group
Means. When we have two groups to compare and we
want to find out whether there are significant
differences between the two groups or not, we can go
for a Mean comparison between two groups.
Independent sample t-test is a powerful test for finding
out the group differences between two group means. To
calculate the Independent sample T-test, we will go to
the Analyze menu and then go to Compare Means. Now
we can see the Independent sample T-test like this:
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The symbol of Independent sample T-test read as t A-B.
It means the group we are comparing A and B are
independent of each other. For example, suppose we
want to compare the salary of males and females or the
population of two cities like Delhi or Mumbai. In this
case, the groups are not related to each other. So we

PSYCHOLOGICAL SCALES scales.arabpsychology.com



https://scales.arabpsychology.com/?p=149249
https://scales.arabpsychology.com
https://scales.arabpsychology.com

What is the definition of the input for an independent sample t-test?

can go for an Independent sample t-test. To calculate
the independent sample t-test, we will open our Data
set. We will go to the File menu, then go to Recently
used Data as follows:
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a Untitled2 [DataSet2] - IBM SPSS Statistics Data Editor

File Edit View

New
Open
Import Data
38 Close
M cae
Save As

fed Save All Data
Export

B3 Cache Data...

Repository
. Print Preview
. Print

Exit

I Mark File Read Only
Revert to Saved File

[ Rename Dataset...
Display Data File Information

Welcome Dialog...
Recently Used Data
Recently Used Files

Collect Variable Information
@ stop Processor
a Switch Server...

-\I e

Ctri+P

Ari+Peariod

' BikFE A

P | 1 CWsers\WSUS\Desktop\Employee Data sav
2 C\Wsers\ASUS\Deskiop\diabetes_costs.sav
3 CWsers\WSUS\Deskop\SPSS File.sav

24
| 2% |

27

Lalal

4 CWsers\ASUS\Desklop\SPSS file 2.sav
S DASPSS File1.sav

[y

Now we will click on the above Employee Data option

and see our Employee Data set as follows:
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@ Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor
Eile Edit View Data Transform Analyze Graphs  Utilities Exensions  Window  Help
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| #id | dagender | glleduc | & jobcat | & salary | & salbegin & jobtime | & prevexp | &b minoity | var |

1 1m 15 3 $35,373 $20,000 98 144 0
2 2m 16 1 $32.000 $15,867 98 36 0
3 3f 12 1 w532 330774 %8 381 0
s 4f 8 1 s413M 520747 98 190 0
5 Am 15 1 $48.000 $35,908 98 138 0
[ 6m 15 1 $24 553 $10,674 98 67 0
7 7m 15 1 s12443 58479 %8 114 0
8 gf 12 1 $19,737 $10,898 98 0 0
9 9f 15 1 $15.389 $7,000 98 115 0
10 10 f 12 1 $20.748 $14,000 98 244 0
" M"f 16 1 $25.000 $17.000 97 143 0
12 12 m 8 1 $30.774 $20,748 97 26 1
13 13 m 15 1 540,278 520,599 97 34 1

. 1 15 1 $35938  $19.489 97 137 1
15 15 m 12 1 $38.000 $29.000 97 66 0
16 16 m 12 1 $27,000 $21,748 97 24 0
17 7m 15 1 $46500  $35.008 a7 5 0
18 18'm 16 3 563000  $40.789 97 70 0
19 19 m 12 1 $35.790 $21.844 96 103 0
20 20 f 12 1 $9.000 $7,000 96 48 0
21 21§ 16 1 SI7674 511,000 % 17 0
2 2m 12 1 s24830  $17.000 % 315 0
23 23 f 15 1 $32.999 $22.748 96 75 0
24 24 f 12 1 $49,939 $30,000 96 124 1
2% 2%5¢ 15 1 §15883 510,848 % 171 1
2% 26 m 15 1 1100  $8,030 % 14 0
27 27 m 15 3 549 399 $34.000 96 96 0
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beginning salary, job timing, previous experience, and
whether they belong to minority or majority group. In
this case, suppose we want to test that there is a
significant difference between the Salary of males and
females. To test that, we can conduct an Independent
sample t-test. Similarly, suppose we want to determine
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whether people from minority categories are taking a
lesser amount of Salary than people from the majority
community. In that case, we can again calculate the
Independent sample t-test. To test the independent
sample t-test, we will go to the Analyze menu and then
go to Compare Means option. In the Compare Means
option, we locate the Independent sample t-test. When
we click on it, we will see a dialog box like this:

@ Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utilities Extensions Window  Help

SEemM - BHLAW 4 BEH 4 96
|

f id ‘ &ge"der L | Independent-SamplesTTest X
1 1m
2 2m _ b § Test Variable(s):
3 3f & Employee Code [id]
n 4t &4 Gender [gender] ~'-'-J— !
,{l Educational Level [educ]
Il 5m &; Employment Category [jobcat]
6 I 6m & Current Salary [salary]
T Tm f Beginning Salary [salbegin]
& Months since Hae [jobtime]
8 8f
f 9 f Previous Experience [prevexp]
& Minority Classification [minority)
10 10f
T
12 12/m
13 13/m
14 14 f
15 15'm Grouping Variable:
16 16/m |—
17 17|m Define Groups
18 18 m
Jk Paste Cancel
— N Lo ) e (Resst (cancet] e |

Now we want to compare people across Gender. In this
case, Gender has been defined as a String variable. So
to calculate any meaningful test, we need to define all
variables as a Numeric variable. So we will change the
definition of the gender variable. We will turn it into a
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Numeric variable from String. So we will go to our
Variable view and look at the Gender as follows:

Employee Datasav [DataSet3] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Extensions Window  Help

SRl e~ HHLF HBH 196

| Name | Type ‘ Width ‘ Decimals ‘ Label ‘ Values | Missing ‘ Columns Align | W ‘ Role

1 Jid Numeric 4 0 Employee Code None None 8 = Right & Scale “ Input
2 |bender | string 3 0 Gender {f, Female}... None 12 = Left &> Nominal “ Input
] educ Numeric 2 0 Educational Level {0, 0 (Missi... None 8 = Right 4l Ordinal N Input
4 jobcat Numeric 1 0 Employment Category {0, 0 (Missi... None 8 = Right &b Nominal “ Input
5 ]salary Dollar 8 0 Current Salary {80, missing... None 8 = Right & Scale N Input
6 salbegin Dollar 8 0 Beginning Salary {50, missing... None 8 = Right & Scale N Input
T jobtime Numeric 2 0 Months since Hae {0, missing}... None 8 = Right & Scale N Input
8 prevexp Numeric 6 0 Previous Experience {0, missing}... None 8 = Right & Scale “ Input
9 minority Numeric 1 0 Minority Classification {0, No}... None 8 = Right & Nominal “ Input

|10 |
1

12 |
13

| u ]
15

Since it's a String, so first, we need to convert the value.
So we will select the row, press Ctrl+F, and then click
on Replace. We will find m and replace it by 1 and then
click on Replace all.
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a *Employee Datasav [DataSet3] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analjze Graphs  Utilities Extensions Window  Help
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Similarly, we will write f and replace it by 2 and click on
Replace all. After this, we will see the following changes
In the Gender variable:
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*Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor
Eile Edit View Data Transform Analyze Graphs Utilities Exensions Window Help
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10 102 12 1 S20,748  $14,000 98 244 0
1 112 16 1 §25000  $17.000 97 143 0
12 121 8 1 $30774  $20.748 97 2 1
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Now we have to redefine this Gender variable. So we
will go to the Variable view option and click on the
Value step of the Gender variable. Now we will select
the female option and define Value as 2 and click on
Change as follows:
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*Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Exensions Window Help

g%lﬂ@b’“ [ M BB mi O [@

I Name | Type | Width | Decimals | Label ‘ Values | Missing Columns ‘ Align | M €

_ 1 id Numeric 4 0 Employee Code None None 3 = Right & Scale

2 gender String 3 0 Gender {f. Female}... None 12 = Left &> Nominal
| 3 educ Numeric 2 0 Educational Level {0, 0 (Missing)}... None 8 = Right £l Ordinal

4 jobcat Numeric 1 0 Employment Category {0, 0 (Missing)}... None 8 = Right &5 Nominal

5 salary Dollar 8 0 Current Salary {80, missing)... None 8 = Right & Scale

6 salbegin Dollar 8 0 Beginning Salary {50, missing)... None 8 = Right & Scale

7 jobtime Numeric 2 0 Months since Hae {0, missing}...  None 8 = Right & Scale

8 prevexp Numeric 6 0 EE— : O i o 2 =nw [ Seo.
9 minority Numeric 1 0 Value Labels %
:|1D ~Value Labels

11
— vale: 2 w
B Label: [Female
[ 14 ] f="Female”
T] m ="Male”
BT o)
|
— [range ]
T] Remove

20

21

22
B ok J{cancel|_reip |
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Again select the male option and define Value as 1 and
click on Change. Now press OKk.
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*Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor

[ Name Type | Width | Decimals | Label ‘ Values | Missing Columns ‘ Align | M
| 1 id Numeric 4 0 Employee Code None None 8 = Right & Scale

2 gender String 3 0 Gender {f. Female}... None 12 = Left &> Nominal

3 educ Numeric 2 0 Educational Level {0, 0 (Missing)}... None 8 = Right fl Ordinal

4 jobcat Numeric 1 0 Employment Category {0, 0 (Missing)}... None 8 = Right &5 Nominal

5 salary Dollar 8 0 Current Salary {80, missing)... None 8 = Right & Scale

6 salbegin Dollar 8 0 Beginning Salary {80, missing}... None 8 = Right & Scale

7 jobtime Numeric 2 0 Months since Hae {0, missing}...  None 8 = Right & Scale

8 prevexp Numeric 6 0 Previous Experience {0, missing)... ~ None 8 = Right __J? Scale
|9 | minority Numeric 1 0 Minority Classification {0, Noj... None 8 = Right lwn:ninal
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Now we can change the Gender from String to Numeric
variable like this:
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*Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Ulilities Extensions Window Help

SHe B e Bl H BE «19(4

| Name | Type | Width | Decimals | Label | Values | Missing Columns Align
1 ] id Numeric 4 0 Employee Code Naone None 8 = Right
2 gender String 3 0 Gender {1, Male}.... None 12 = Left
| 3 ]educ Numeric 2 2 Variable Type %
4 jobcat Numeric 1
: 5 ] salary Dollar 8 @Numenc
. 6 salbegin Dollar 8 © comma wiath: |3 |
7 |jobtime Numeric 2 © Dot Decimal Places: o |
8 prevexp Numeric 6 © Scientific notation
| 9 minority Numeric 1 © Date
© Dollar
© custom currency
© string

i

© Restricted Numeric (integer with leading zeros)

The Numeric type honors the digit grouping setting, while the Restricted Numeric never

uses digit grouping.
Lok J{ cancer][_netp |

A~ N =

Now variables have been defined. We will go to

Compare Means option and click on an Independent

sample t-test. So we want to compare genders for their

salary. We will take the Salary as our Test variable and

Gender as a Grouping variable. So the Salary is our

dependent variable, and Gender is our independent

variable.
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@ *Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs Utilities Extensions Window  Help

SHE M e~ BlHafl A B . 9le
|

:Il &id | &) gender | _| 8 Independent-Samples T Test 1% _]
1 1 1

2 | 2 1 TestVariable(s):
Il 3 2| | ¢ Employee Code (id] & Current Salary [salary]
— 4 } 2 > 4l Educational Level feduc]

& Employment Category [jobcat]

II 5 1 f Beginning Salary [salbegin]
| 6 } 6 1 & Months since Hire [jobtime]

T 7 1 49 Previous Experience [prevexp]
. = } s 2 &b Minority Classification [minority] pr
[ 3 | 3 2
| 10 10 2
BT :

12 12 1

13 13 1

14 14 2
Il 15 1 E groupingﬂablf:
T‘ 16 ] [lgender? ) I
A 17 1 | petne Groups..|
= 1 () oo (msan) ooin Cin )

In the above image, under the Grouping variable, we
can see two question marks. It means we need to define
our groups. So click on Define Groups option and write
1 for Group 1 and 2 for Group 2. So, 1 is for males, and
2 is for females. We can also define the Cut point
instead of defining the groups. For example, suppose
we have an exact salary and want to take a cutoff
salary, which could be a median salary or any salary,
suppose 10000. In that case, SPSS will compare two
groups less than 10000 and more than 10000, and we
will do significant testing between these two groups.
Currently, we are using our group definition, so click on
Continue like this:
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@ *Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs  Utiliies Exensions Window  Help

fﬁH@ e &%. 1] ﬁ@ ..ﬂ%@@

&id [ & gender ‘._ E8 Independent-Samples T Test b J
1 1 1
2 | 2 1 Test Variable(s): @
- 3 2 & Employee Code [id] & Current Salary [salary]
;I] . ) 4l Educational Level [educ) @
L &b Employment Category [jobcat]
Il 5 1 & Beaginning Salary [salbegin]
6 6 1 | | & Months since Hire [jobtime]
7 7 1 f Previous Experience [prevexp]
.T‘ 3 2 @5 Minority Classification [minority] 2 Define Groups x
9 9 2 }
10 10 2 ® ;eos Tﬁeavalues
BT 2 will ]
| 12 12 1 Group2: (2
13 13 1 © Cut point
14 14 2 —
15 15 1
16 16 1
17 17 1
1B 18 1 [ ww (e |
19 19 1 . —

Now we will click on Options where we can select a 95%
Confidence Interval by default. If we want to change, we
change it and make it as 99%, but let's begin with the
default value 95%.
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@ *Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor

File Edit View Data Transform Analyze Graphs  Utilities Exensions Window  Help

SHEeE R -~ Bl A BE 196
|

(e

&id [ &)gender |_ 8 Independent-Samples T Test x
1 1 1
- 2 ] 2 1 Test Variable(s): Options...
Il 3 2 & Employee Code [id] & Current Salary [salany]
ﬁ " 3 4l Educational Level [educ] _ Bootstrap... |
&3 Employment Category [jobca] Independent-Samples T Test: Optians X
5 5 1 & Beginning Salary [salbegin]
| 6 6 1 & Months since Hire [jobtime] Igonﬁdence Interval Percentage: ‘g5| |%|
7 7 1 & Previous Experience [prevexp]
T‘ 8 2 &5 Minority Classification [minority] Missing Values
II 9 2 @ Exclude cases analysis by analysis
© Exclude cases listwise
0 10 2 i :
1 1 2 y 9
— - 1 (ot _cancet ] _rtep |
13 13 1
14 14 2 !
Grouping Variable:
15 15 1
:I : I—g-nd-r(m
1
1
1

19 19

In the missing value, we are going with the default value
Exclude case analysis by analysis. It basically leads to
a lesser amount of data loss as compare to Exclude
cases listwise. So we will take it as an analysis by
analysis method. Now we will click on Continue.
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Employee Data.sav [DataSet3] - IBM SPSS Statistics Data Editor
File Edit View Data Transform Analyze Graphs Utilities Exensions Window  Help

SHE Ll A B a4 ‘@@l

| Lid | @gender x

1 1 1

2 2 1 Test Variable(s): Options..

3 3 2 & Employee Code [id] I & Current Salary [salary] l i

4 4 2 d Educational Level [educ] E
& Employment Category [jobcat] Independent-Samples T Test: Options x I

5 5 1 & Beainning Salary [salbegin]

6 6 1 | | & Months since Hire [jobtime] Confidence Interval Percentage: |9 %

7 7 1 f Previous Experience [prevexp] I I

3 8 2 &b Minority Classification [minority] Missing Values

= 9 ) @ Exclude cases analysis by analysis k

Exclude cases listwise

10 10 2 0o : |

1 11 2

12 12 1 - - [
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14 14 2

S - |
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Now we will click on Ok, and after that, we will see the
following Output:

ﬁ *Output] [Document1] - IBM SPSS Statistics Viewer - o X
Eile  Edit View Data Jransform Insert Fgrmat  Analyze  Graphs  Utliies Eglensions  Window  Help

ErECe N s 1T rY 10

& (& Output e
iy ';“r"B " FILE="C:\Users\ASUS\Desktop\Employee Data.sav'.
T ) Tite DATASET NAME DataSetl WINDOW=FRONT.
& Hotes DATASET ACTIVATE Datasetl.
L) Active Dataset
@ Group statistics SAVE OUTFILE='C:\Users\ASUS\Desktop\Employee Data.sav’
@ Independent Sam| /coupREsSED,
I-TEST GROUPS=gender(l 2)
/MISSING=ANALYSIS

/VARIAEBLES=salary
JCRITERIA=CT(.95) .

# T-Test

[DataSetl] C:\Users\ASUS\Desktop\Employee Data.sav

Group Statistics
Sta. Error
Gender N Mean Std. Deviation Mean
CurrentSalary  Male 18 $34,088.06 $11,650.697 $2,746.096
Female 12 §15427.42 $4,630.856 $1,336813

Independent Samples Test
Levens's Testfor Equality of
Variances ttest for Equality of Means

95% Confidence Interval of the
rence

Mean Std. Eror
F Sig. 1 df Sig. (2-tailed) Difference Difference Lower Upper
Current Salary  Equal variances 7631 010 5254 28 000  $18,660638  $3551.847  $11384805  §25936.473
assumed
Equal varlances not 6110 23935 000  $18,660639  §3054196  $12356178  §24,965.000
assumed
(C———TF)|
Encoding status area IBM SPSS Statistics Processorisready | | |Unicode:ON
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